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Online Claims & SeSocial Security Online

Hours of Operation : If you get benefits, you can Other Things Yo u
(All times ET) Can Do Online
Weekdays 5 AM - 1 AM Change your address or telephone number .Saturday 5 AM - 11 PM Apply for
Sunday 8 AM -
11 :30 PM Get a replacement Medicare Card Social Security

benefits
5 AM - 11 PM on Request

	

Proof of Income letter . extra help wit h
these holidays: Get a letter that verifies your Social Security ypyr.MedicarQ
New Years Day benefit information . prescription .0 ryg
Independence Day costs
Thanksgiving Day

Get a Form 1099/10425 -- Social Security Find out if youqualifyChristmas Day
Benefit Statement . for
Replace the lost, damaged, or missing tax extra J-1p.ip wit hHours for all other

holidays are : summary of your Social Security benefits for Your MeOlOP.
5 AM - 1 AM 2005 (not available for SSI) . prescription dru g

costs
Get a password when Social Security ,

Field Office Locator o You want password access to Suppigrrigata i
Use your ZIP code to Income
locate the closest Social information about your benefits ,
Security Office . o Your password request code has (BSI), or _othe r
Available expired, or benefits
Weekdays (except o You lost, forgot, or do not have your EstimaAg._ yqur. tutu i-P
2 AM - 3 AM) password or password request code . benefits
Saturday 5 AM - 11 P M
Sunday 8 AM - Request a Socia l
11 :30 PM Block online and automated telephone access Security Statemen t
Holidays 5 AM - 11 PM to your personal information . Use our online business

services
[Top] If you have a

passwordIf you have a password, you can . . .

• Check your information and benefits .
See the contact, direct deposit, Medicare an d
payment information we have on file for you .

Request	 or change directdeposit .

• Qbopse_ypur password .
If you received a letter from us about passwor d
services, you can choose your password o r
block access to your personal information .

Changeypy[pAs .word .

What You Can Do Onlin e
Updated : 05/11/06

ces

[Top]

http : //mwww.b a . s s a. gov/online services/
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Overview of Pages in i1099

Screen Number Screen Name

Application Pages

ee001 a Request an SSA-1099/1042S for Tax Infonnation

ee001 b This Service Is Currently Unavailabl e

ee002 Legal Acknowledgemen t

ee003 Public Agreemen t

ee004a General Infonnation About You

ee004b 'General Infonnation About the Deceased

ee005a Please Log I n

ee005b Please Log I n

lee006a Confirmation

'ee006b Confirmation

Message Pages

msgO51 Cookies Not Enable d

msgO65 How to Report a Change of Address and Request a Replacement SSA-1099/1042 S

msgO66 'How to Report a Change of Address and Request a Replacement SSA-1099/1042 S

msgO62 How to Request Your Replacement SSA-1099/1042 S

msgO36 Information about Time Limit s

msgO61 Internet Security Policy

msgO24 Special Instructions for People Who Are Blin d

msg063 'The Infonnation You Entered Does Not Match Our Record s

msgO28 This Service Is Not Available at this Tim e

msgO45 This Service Will Shut Down Within 30 Minutes

msgO30 We Are Processing Your Request . . .

msgO64 You Have Reached the Limit on the Number of Request s

msgO25 Your Session Has Expire d

msgO27 Unable To Complete Your Request at this Tim e

msgO37 Unable to Process Your Request

http://eis .ba.ssa.gov/appages/i 1099/index .html
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Social Security C:)nline

	

Replace an SSA-1099/1042 S
ax Year 2005)

www.socialsecurity .gov

Request an SSA -
1099/1 042S for Ta x
Information

You can request a copy of your most recent SSA-1099 or SSA -
1042S using the buttons at the bottom_of thspage .

What is an SSA-1099/1042S Social

	

. An SSA-1099 is mailed to you in January showing the tota l
Security Benefit Statement?

		

amount of benefits you received in the previous year . If you
are a nonresident alien who received or repaid Socia l
Security benefits last year, you will receive an SSA-1042S
instead .

• If you need a replacement SSA-1099 or SSA-1042S for a n
earlier tax year, contact us .

• You can request an SSA-1099/1042S for yourself or on
behalf of a deceased beneficiary if you are receiving benefits
on the same record as the deceased .

• For security reasons, there is a 30 minute time limit t o
complete each page . We..will_warn ...you when you run out of
time . You can get more time to finish .

• A copy of your SSA-1099/1042S will arrive in the mail i n
about 10 days (30 days if you live outside the United
States) . If you need it sooner, contact your loCal_Socia l
Security Office .

• The SSA-1099/1042S will be mailed to the address on fil e
at Social Security .

• If you have moved, you must rep0rt..your_changeofaddres s
to us before we can process your request .

• If you recently reported a change of address to SSA, yo u
need to contact us to make your request .

For more information on taxation of Social Security Benefits, or to
order the publication "Tax information for Olde r
Americans" (Publication #554), call the IRS at 800-829-3676 or visi t
the IRS Web site .

Special Instructions for People Who are Blin d

Block Access to Your Personal

	

If you want to prevent online and automated telephone access t o
Information

		

your personal information, you can blockaccess to .your .personal
information .

What Do You Want to Do ?

Request for Myself

Request for a Deceased Person

Priya..r..y Policy I A.cc..essihility_En icy I irate. etsec.urity_eeky I Site Map I FeeaaJi

What You Should Kno w

What to Expec t

If You Have Moved

For More Informatio n

http ://eis .ba.ssa.gov/appages/ilO99/eeOOla.html
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Social Seem* C: nline

	

Replace an SSA-1099/1o42 S
www socialsecurity .gov

This Service I s
mill Currently Unavailable

The SSA-1099/1042S for Tax Year 2005 will be mailed before
January 31, 2006 .

You can request a replacement SSA-1099/1042S for Tax Year 2005
on or after February 1, 2006 .

If you need a replacement SSA-1099/1042S for Tax Year 2004 o r
earlier:

. Call us toll-free at 1-800-772-1213, or our toll-free TTY
number, 1-800-325-0778 ; o r

• Visit your local Social Security Office .
• If you live outside the United States, see Service Around th e

World .

Privacy Policy i Accessibility Policy I Internet Security Policy i Site Map I Feedback

http://eis .ba.ssa.gov/appages/ilO99/eeOOlb.html
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Social Security Online

www.socialsecurity .gov

Replace an

	

-
ax Year 2005)

042S9

Legal
Acknowledgemen t

Social Security provides this website for your convenience .

Any person who knowingly and willingly makes any representatio n

1. that is false to obtain information from Social Security
records, and/o r

2. that is intended to deceive the Social Security Administratio n
as to the true identity of the individual ,

could be punished by a fine or imprisonment, or both .

I have read the above statement and am the individual to whom th e
SSA-1099/1042S information applies .

Exit

	

Continue

http ://eis .ba.ssa .gov/appages/i1099/ee002 .html

	

6/7/2006



Public Agreement

	

Page 1 of 1

So cia .l Security Online

	

Replace an SSA-logg/lo42 S
ax Year 2005)

Public Agreement

Social Security provides this website for your convenience .

Social Security is allowed to collect the facts on this form unde r
Section 205 of the Social Security Act. We need these facts to
quickly identify who you are and provide the information yo u
requested . Giving us these facts is voluntary . However, without the m
we may not be able to give you the information that you want . The
Social Security Administration will not use the information for an y
other purpose. If you want to read more information on this subject ,
read The Collection and Use of Information from Your Application .

This information collection meets the requirements of 44 U .S .C . §
3507, as amended by section 2 of the Paperwork Reduction Act o f
1995 . You do not need to answer these questions unless we displa y
a valid Office of Management and Budget control number . The OM B
control number for this form is 0960-0583, expiration date
01/31/2007 . We estimate that it will take about 10 minutes to rea d
the instructions, gather the facts, and answer the questions . Yo u
may send comments on our time estimate above to : SSA, 1338
Annex Building, Baltimore, MD 21235-0001 . Send only. comment s
on our time estimate to this address, not the completed form .

www.socialsecurity .gov

The Privacy Act Statemen t

Paperwork Reduction Act

By using this website, you agree to its limitations .

I Disagree I Agree

http ://eis .ba.ssa.gov/appages/ilO99/eeO03.html
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Replace. an SSA-1099/1042S
fax Year 2005)

General Information About You

Social Securi y nlin e

www.socialsecurity .gov

General Information
About You

Why do you need a replacement SSA -
1099/1042S ?

Have you had a change of address that
has not been reported to Social

	

' Ye s
Security?

	

No

Previous

	

Continue

http://eis .ba.ssa.gov/appages/ilO99/eeO04a .html
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General Information About the Deceased
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Social Security On

	

Replace an SSA-1099/1042S
(Tax Year 20o5)

www.socialsecurity .gov

Why do you need a replacement SSA-
1099/1042S?

[ Previous

	

Continue

General Information
About the Deceased

http ://eis .ba.ssa.gov/appages/i1099/eeO04b .html
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Please Log In
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Social Security- Onlin e

Month, Day, Year

	

Replace an SSA-1099/1042S
ax Year 2005)

www.socialsecurity .gov

Please Log I n

Please provide the following information to identify yourself . Be sure
to type your name as it is shown on your Social Security Card .

	 Denotes required field

` Your Social Security Number :

	

(without dashes or spaces )
Use your own number even if you are
receiving benefits as a spouse, parent or chil d
under another person's number .

Your Name :
First, Middle Initial (if any), Last, Suffix (if any )

Other Last Name (if any) :
For example, your name as shown on a
recent letter from Social Security or you r
maiden name .

Your Date of Birth :

Previous t	 Continue

http://eis .ba.ssa.gov/appages/ilO99/eeO05a.html
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Replace an SSA-1o99/1042S
'fax Year 2005)

Please Log I n

Social Security Online

www.socialsecurity .gov

Please Log I n

n z.

Please provide the following information to identify yourself. Be sure
to type your name as it is shown on your Social Security Card .

If you are requesting an SSA-1099/1042S fora decease d
beneficiary, you must be receiving benefits as a spouse, parent o r
child on the same record as the deceased .

*	 Denotes required field
* Deceased Beneficiary's Social Security

	

(without dashes or spaces )
Number :

Verify who you are

Your Social Security Number :

	

(without dashes or spaces)
Use your own number even if you are
receiving benefits as a spouse, parent or child
under another person's number .

Your Name :
First, Middle Initial (if any), Last, Suffix (if any )

Other Last Name (if any) :
For example, your name as shown on a
recent letter from Social Security or your
maiden name .

` Your Date of Birth :
Month, Day, Year

Previous

	

Continue

http://eis .ba.ssa.gov/appages/i 1099/ee005b .html
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Social Security Online

www.socialsecurity .gov

Replace an SSA-1099/1042S
Tax Year 2005)

Confirmation

Thank you, Joan Public .

What You Should Know

	

We received your request for a copy of an SSA-1099/1042S on Apri l
3, 2006 .

. You should receive your replacement SSA-1099/1042S by
April 13, 2006 (May 3, 2006 if you live outside the Unite d
States) .

• It will be mailed to the address Social Security has on file fo r
you .

• If you do not receive it by April 13, 2006 (May 3, 2006 if yo u
live outside the United States), please call us Monday-Friday
7 :00 a .m.-7 :00 p .m. at 1-800-772-1213 or, if you are deaf o r
hard of hearing, on our TTY number at 1-800-325-0778 .

• If you live outside the United States, see ServiceAround the
World .

Use your browser's "print" function to print this page for you r
records .

Does someone else in your househol d
want to request a replacement SSA-

	

Ye s
1099/1042S?

0

Continue

Privacy Policy I Accessibility Policy l Internet Security Policy l Site Map I Feedbac k

http://eis .ba.ssa.gov/appages/ilO99/eeO06a.html
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Replace an SSA-1o99 j1o42S
(' Year 2005)

Confirmation

Social Security Online

www.socialsecurity .gov

Confirmatio n

Thank you, John Public .

What You Should Know

	

We received your request for a copy of an SSA-1099/1042S for a
deceased beneficiary with the Social Security Number 123-45-6789
on April 3, 2006 .

. You should receive the replacement SSA-1099/1042S by
April 13, 2006 (May 3, 2006 if you live outside the United
States) .

• It will be mailed to the address Social Security has on file fo r
you .

• If you do not receive it by April 13, 2006 (May 3, 2006 if yo u
live outside the United States), please call us Monday-Frida y
7:00 a .m.-7 :00 p .m. at 1-800-772-1213 or, if you are deaf o r
hard of hearing, on our TTY number at 1-800-325-0778 .

• If you live outside the United States, see Service Around the.
World .

Use your browser's "print" function to print this page for you r
records .

Does someone else in your househol d
want to request a replacement SSA-

	

Ye s
1099/1042S?

No

Continuej

Privacy Policy I Accessibility Policy I Internet Security Policy I Site Mao I Feedback

http://eis .ba.ssa.gov/appages/iIO99/eeO06b.html
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Social Security Online

www.socialsecurity .gov

Replace an SSA-1o99/I042S
(Fax Year 2005)

Cookies Not Enable d

To get a replacement SSA-1099 or 1042S (for non-citizens/non-
residents) online, you must enable "cookies" on your computer . We
use "session cookies" that we store on your computer only durin g
your visit. The session cookie keeps you from losing informatio n
you've entered for a business transaction with us if, during your visit ,
you leave our website and return .

Once you turn off your computer or stop using the Internet, th e
cookie is erased .

To enable cookies, follow the instructions below for the browse r
you're using .

Microsoft Internet Explorer 6 .0+

• Select "Internet Options" from the Tools menu .
▪ Click on the "Privacy" tab .
• Click the "Default" button (or manually slide the bar down to

"Medium") under "Settings" .
• Click "OK" .

Microsoft Internet Explorer 5 . x

• Select "Internet Options" from the Tools menu .
• Click on the "Security" tab .
• Click the "Custom Level" button .
• Scroll down to the "Cookies" section .
▪ Set "Allow cookies that are stored on your computer" to

"Enable" .
• Set "Allow per-session cookies" to "Enable" .
• Click "OK" .

Mozilla Firefox (1 .0 final release and earlier)

• Go to the "Tools" menu .
• Select "Options" .
• Select the "Privacy" icon in the left panel .
• Check the box corresponding to "Allow sites to set cookies" .
• Click "OK" to save changes .

Netscape 7 .1/Mozilla 5 . 0

▪ Select "Preferences" from the Edit menu .
• Click on the arrow next to "Privacy & Security" in the scrollin g

window to expand .
• Under "Privacy & Security", select "Cookies . "
• Select "Enable all cookies" .
▪ Click "OK" .

http ://eis .ba.ssa.gov/appages/ilO99/msgO51 .html

	

6/7/2006



Cookies Not Enabled
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Microsoft Internet Explorer 4 . x

• Select "Internet Options" from the View menu .
• Click on the "Advanced" tab .
• Scroll down to find "Cookies" within the "Security" section .
• Select "Always accept cookies" .
• Click "OK" .

Netscape Communicator 4 . x

Select "Preferences" from the Edit menu .
• Find the "Cookies" section in the "Advanced" category .
• Select "Accept all cookies" (or "Enable all cookies") .
• Click "OK" .

Exit

	

Start Ove r

http ://eis .ba.ssa.gov/appages/i 1 099/msgO5 1 .html
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How to Report a Change of Address and Request a Replacement SSA-1099/1042S
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i&xial Security Online

	

Replace an SSA-1o99/I042S
(Tax Year 2005)

How to Report a Chang e
of Address and Request
a Replacement SSA-
109911042S

You told us you have moved and have not reported this to us . To
report your new address and request a replacement SSA -
1099/1042S at the same time, please call or visit Social Security .

To contact Social Security :

	

. In the United States :
o call us at 1-800-772-1213 Monday through Frida y

between 7 a .m. and 7 p .m .
o call our toll-free TTY number, 1-800-325-0778, if yo u

are deaf or hard of hearing, Monday through Friday
between 7 a .m. and 7 p .m ., o r

o visit your local Social Security Office .

If you live outside the United States, see Seryice_Around th e
World .

Close this window to return to the application .

www.socialsecurity .gov

http://eis .ba.ssa.gov/appages/i 1099/msgO65 .html
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How to Report a Change of Address and Request a Replacement SSA-1099/1042S
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Social Security Online

www .socialsecurity .gov

Replace SSA-1099/104 S
(Tax Year 2005)

How to Report a Chang e
of Address and Request
a Replacement SSA -
1099/1 042S

You told us you have moved and have not reported this to us . T o
report your new address and request a replacement SSA -
1099/1042S at the same time, please call or visit Social Security .

To contact Social Security :

	

. In the United States :
o call us at 1-800-772-1213 Monday through Friday

between 7 a .m . and 7 p .m .
o call our toll-free TTY number, 1-800-325-0778, if you

are deaf or hard of hearing, Monday through Frida y
between 7 a .m . and 7 p .m., o r

o visit your local Social Security Office .

If you live outside the United States, see Servic e.Around_the
World .

Exi t

http ://eis .ba.ssa .gov/appages/ilO99/msgO66 .html
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How to Request Your Replacement SSA-1099/1042S
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Social Security Online

	

Replace an SSA-1o99/1.o42S
(Tax Year 2005)

www.socialsecurity .gov

How to Request You r
Replacement SSA-
1099/1 042S

Were sorry you cannot request a replacement SSA-1099/1042 S
online . You must call or visit us to request a replacement SSA -
1099/1042S .

To contact Social Security :

	

. In the United States :
o call us at 1-800-772-1213 Monday through Frida y

between 7 a .m. and 7 p .m .
o call our toll-free TTY number, 1-800-325-0778, if yo u

are deaf or hard of hearing, Monday through Frida y
between 7 a .m. and 7 p .m., o r

o visit your local Social Security Office .

• If you live outside the United States, see Service Around the
World .

Exit

http ://eis .ba.ssa.gov/appages/ilO99/msgO62 .html
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Social Security Online

www.socialsecurity .gov

Replace an SSA-1099/1042S
(Tax Year 2005)

Information about Time
Limits

For security reasons, there are time limits for your work on each
page .

▪ You will receive a warning after 25 minutes on a page tha t
will allow you to extend your time .

• After the third warning on a page, you must move to anothe r
page or your time will run out and you will be logged out .

▪ If you have turned JavaScript off in your browser, you will not
receive these warnings . After spending 30 minutes on a
page, you must move on to another page or you will b e
logged out .

Do not use the Back button on your browser to move backward .

Do not use the Enter key to move around in the application .

Close this window to return to the application .

http://eis .ba.ssa.gov/appages/i 1099/msg036 .html
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Internet Security Policy
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Social Security Online Replace an A-1 o 99/10 42S
TaxYear 2005)

www.social secu rity .gov

Internet Security Policy

Is it safe to transmit information to the

	

SSA is taking all reasonable and proper measures, includin g
Social Security Administration over the encryption, to ensure that your personal information is disclosed only
Internet?

	

to you . However, the Internet is an open system and there is n o
absolute guarantee that others will not intercept the persona l
information you have entered or requested and decrypt it . Althoug h
this possibility is remote, it does exist .

Encryption means that all information relating to you and you r
account is scrambled and locked with a mathematical key during th e
electronic transfer . Most browsers have an icon such as a key or a
lock to represent an encrypted mode or session . A broken key, ope n
lock, or no lock indicates that the session or mode is not encrypted .

Why is special software necessary to

	

So that your online request can remain confidential, SSA uses a
access the Internet application?

	

security protocol (method) called Secure Sockets Layer (SSL) for
this application . You must use a Web browser that supports SSL .
Netscape Navigator and Microsoft Internet Explorer are tw o
browsers that support SSL . Using this security protocol, al l
information sent between your computer and our server is encrypted
before being sent over the Internet .

Why SSL?

	

SSL provides a high level of security and is the security protoco l
supported by more browsers than any other. It is estimated tha t
about 92% of Web browsers have an SSL browser available for thei r
use .

I have the right software and I am trying We have found that a number of business, government, an d
to connect during your posted

	

educational networks do not have their firewalls configured to allow
business hours, but I still cannot

	

passage of secure Web traffic . Check with your system s
access your form . Why?

	

administrator to determine if this is the case at your site . If this is th e
case, you will not be able to access this application web site .

Close this window to return to the application .

What is encryption ?

http://eis .ba.ssa.gov/appages/ilO99/msgO61 .html
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Special Instructions for People Who Are Blind
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Social Security Online

	

Replace an SSA-1o99/1o42S
ax Year 2(015)

www.socialsecurity .gov

The following instructions are for screen reader users like JAWS an d
Window-Eyes and Browser based readers like Home Page Reader.

In order to fill out this application you will be required to tab to eac h
control and provide the requested information . Instructional text
usually occurs at the beginning of each screen and can also b e
accessed by tabbing through the screen . Tab indices have also bee n
added to allow for tabbing through text . Additionally, consisten t
headers have been set up to access questions an d
examples/instructions more easily . All headers that are at level 3 wil l
have additional help text . Additionally, the titles of each page ar e
header level 1, and they will have general help information .

Unless you have turned Javascript off in your browser, you wil l
receive a warning after 25 minutes and you can extend your time o n
the page . After the third warning, you must move to another page, o r
your time will run out and your work on that page will be lost .

At the end of most screens there is a Continue button to allow th e
user to go to the next page and a Previous button to return to th e
prior page . The hotkey ALT + C is associated with the Continu e
button, ALT + P for the Previous button, and ALT + X for the Exi t
button . Press Alt + C or ALT + P and then press Enter to mov e
forward or back, or ALT + X to exit .

Close this window to return to the application .

Special Instructions for
People Who Are Blin d

http://eis .ba.ssa.gov/appages/i 1099/msg024 .html
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The Information You Entered Does Not Match Our Records
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Social Security C r line Replace SSA-1099/1042S
(Tax Year 2005)

www.socialsecurity .go v

Please check this information :

To contact Social Security :

▪ If you typed the wrong information, you will need to correct i t
before continuing .

• If the information is correct, contact Social Security . Be sure
to tell the representative that you tried to complete your
request online and received this message .

• Call our toll-free number, 1-800-772-1213 . Explain that yo u
are unable to complete your request online . If you are deaf or
hard of hearing, call our toll-free TTY number, 1-800-325-
0778 . Representatives are available Monday through Frida y
from 7 a .m. to 7 p .m .

• Go to your local Social Security Office and tell the
representative that you were unable to complete you r
request .

• If you live outside the United States, see Service Around the
World .

Exit

	

Previous

The Information Yo u
Entered Does Not Matc h
Our Records

http ://eis .ba. ssa .gov/appages/i1099/msgO63 .html
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This Service Is Not Available at this Time

	

Page 1 of 1

Social Security Online

	

Replace an SSA-1o99/1o42S
Year 2005)

www.socialsecurity .gov

This Service Is No t
Available at this Time

This service is available during the following hours (Eastern time) :

Monday through Friday : 5 :00 AM - 1 :00 AM
Saturday : 5 :00 AM - 11 :00 PM
Sunday : 8 :00 AM - 10 :00 PM
Holidays : 5 :00 AM - 11 :00 PM

Exit

http ://eis .ba.ssa.gov/appages/ilO99/msgO28.html
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This Service Will Shut Down Within 30 Minutes

	

Page 1 of 1

Social Security Online

	

Replace an SSA-1099/1,042S
(Tax Year 2005)

www.socialsecurity.gov

This Service Will Shut
Down Within 30 Minute s

The replacement 1099/1042S service is available during th e
following hours (Eastern Time) :

Monday through Friday : 5 :00 AM - 1 :00 A M
Saturday : 5 :00 AM - 11 :00 P M
Sunday : 8 :00 AM - 10 :00 PM
Holidays : 5 :00 AM - 11 :00 PM

Select Continue to start your request now . If the system shuts dow n
before you finish it, you will have to begin again when the syste m
becomes available .

Select Exit to go to the Social Security home page .

Exit

	

Continue

http://eis .ba.ssa.gov/appages/i1099/msgO45 .html
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Page 1 of 1We Are Processing Your Request . . .

Socia 1 Security Online

www.socialsecurity .gov

Replace an SSA-1099/1.042S
(Tax Year 2005)

A"‘ We Are Processin g
, Your Request. . .

Please wait a moment before selecting the Continue button .

Continue

http ://eis .ba.ssa .gov/appages/ilO99/msgO30 .html
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You Have Reached the Limit on the Number of Requests

	

Page 1 of 1

Social Security Online

	

Replace an SSA-1o99/1o42S
Ci'ax Year 2005)

www.socialsecurity .gov

You Have Reached th e
,b

M~ r
Limit on the Number of
Requests

We have not been able to match the information you entered wit h
our records .

To resolve the discrepancy :

	

. Call our toll-free number, 1-800-772-1213 . If you are deaf o r
hard of hearing, call our toll-free TTY number, 1-800-325-
0778 . Representatives are available Monday through Frida y
from 7 a .m. to 7 p .m .

• Call or visit your local_Social SecurityOffice .
• If you live outside the United States, see Service Around_ the

World .

Exi t

http://eis .ba.ssa.gov/appages/i 1099/msg064 .html
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Your Session Has Expired

	

Page 1 of 1

Social Security Online Replace an SSA-1099/1042S
(Tax Year 2005)

www.socialsecurity .gov

Your Session Has
Expired

If you would like to make this request online, you may select th e
Start Over button below . Select Exit to go to the Social Securit y
home page .

Exit

	

Start OverJ

http:Heis .ba.ssa.gov/appages/ilO99/msgO25 .html
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Unable To Complete Your Request at this Time

	

Page 1 of 1

Soda:l Security Online

	

Replace an SSA-1099/1042S
(Tax Year 2005)

www.socialsecurity .gov

_".

	

Unable To Complet e
Y Your Request at this

Time

We are sorry for the inconvenience, but we cannot process you r
request at this time .

If you still wish to make your request, you may :

▪ Try again later, o r
• Call or visit us

o In the United States :
. call us at 1-800-772-1213 Monday throug h

Friday between 7 a .m. and 7 p .m .
▪ call our toll-free TTY number, 1-800-325-

0778, if you are deaf or hard of hearing ,
Monday through Friday between 7 a .m . and 7
p .m., or

▪ visit your local Social Security Office .

o If you live outside the United States, see Service
Around the_World .

Exi t

http://eis .ba.ssa.gov/appages/i 1 099/msgO27 .html
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Social Security Online

	

Replace an SSA-1o99/I042S
(Tax Year 2005)

www.social secu rity .gov

If the information you gave us is correct, were sorry but this servic e
is not available to you .

If the information you gave us is correct and you are currentl y
receiving benefits, online access to your account may be blocked .
For assistance, please call us at 1-800-772-1213, Monday throug h
Friday between 7 a .m . and 7 p .m. If you are deaf or hard-of-hearing ,
call our toll-free TTY number, 1-800-325-0778, Monday throug h
Friday between 7 a .m. and 7 p .m .

Return to Online Services

Unable to Process You r
Request

http://eis .ba.ssa.gov/appages/ilO99/msgO37 .html
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